Can facial similarity enhance trust in autonomous driving?

Meijering, V.C.S.

Award date:
2014

Link to publication

Disclaimer
This document contains a student thesis (bachelor's or master's), as authored by a student at Eindhoven University of Technology. Student theses are made available in the TU/e repository upon obtaining the required degree. The grade received is not published on the document as presented in the repository. The required complexity or quality of research of student theses may vary by program, and the required minimum study period may vary in duration.

General rights
Copyright and moral rights for the publications made accessible in the public portal are retained by the authors and/or other copyright owners and it is a condition of accessing publications that users recognise and abide by the legal requirements associated with these rights.

- Users may download and print one copy of any publication from the public portal for the purpose of private study or research.
- You may not further distribute the material or use it for any profit-making activity or commercial gain.
Can facial similarity enhance trust in autonomous driving?

by ing. Valérian C.S. Meijering
identity number 0635488

in partial fulfilment of the requirements for the degree of

Master of Science

in Human Technology Interaction

Supervisors:

Dr. Jaap Ham

Frank Verberne Msc
Abstract

Autonomous vehicles on the road are becoming reality. However, the first autonomous vehicles on the road still require a human driver who can switch the driving task between themselves and autonomous vehicle. In order to hand over control to the vehicle to perform the driving task safely, the driver needs to have enough trust in the system. Previous research suggested that using psychological trust cues to enhance trust in a system showed promising results. Facial similarity is one of those trust cues and will be used in this study through a virtual morphed agent that is either blended with the face of a participant, or another person. We expected that a morphed agent looking similar to the participant will be given more control than one that looks dissimilar. Participants performed three tasks: an investment game, a route planner game and seven driving scenarios in a virtual environment. During these tasks, participants either interacted with a facially similar or facially dissimilar agent. No evidence was found for a behavioral trust effect. On the cognitive level however, participants in the facially similar condition trusted and liked the morphed agent more. Furthermore, participants felt more similar to the morphed agent in the facially similar condition and found him more competent. Overall, results suggested facial similarity can successfully be used as a tool to increase trust in a virtual morphed agent on a cognitive level.
1 Introduction

In the Netherlands, passenger vehicle ownership of the past ten years has increased with more than one million vehicles to almost eight million (CBS, 2013). Costs of traffic jams and delays, accidents and environmental damage by traffic in the Netherlands accounted for almost 20.9 billion euro's in 2012 (Mobiliteitsbalans 2013, 2013). One of the potential solutions to decrease these problems is the introduction of autonomous vehicles or partial autonomous vehicles (where the driver can regain control again). Possible advantages of these vehicles are fewer traffic collisions, increased roadway capacity and reduced traffic congestion due to better traffic management (Cowen, 2011; O’Toole, 2009). As future scenarios predict higher road density, developing separate lanes for autonomous vehicles are a solution but a costly one. Therefore, vehicle manufacturers are currently restricted to develop autonomous vehicles that interact in the same environment as human drivers. However, this brings up a human-machine interaction that has never been applied in such a context. A very important aspect in this interaction is trust as it determines whether one is willing to successfully work with such automated technologies in a complex driving environment (Lee & See, 2004; Vries, 2004; Youngs, 2013). It is uncertain whether such automated technologies can provide an expectation that delivers enough persuasion to successfully use these technologies. Knowledge of trust can help to solve this issue. Although no concrete definition of trust exists, Mayer et al. proposed a generally accepted description (Mayer, Davis, & Schoorman, 1995):

The willingness of a party to be vulnerable to the actions of another party based on the expectation that the other will perform a particular action important to the trustor, irrespective of the ability to monitor or control that other party. (p. 712)

In the context of trust in automated systems such as autonomous vehicles, system trust is the interaction between system and user that takes place voluntary with an expected benefit for the user: a system that is capable of taking over control of the vehicle and bringing its user safe to a destination (de Vries, 2004). However, because of the involved risk this expectation is not without uncertainty about the actual performance outcome. Increasing system trust could therefore be beneficial to a positive outcome by reducing uncertainty.

One way of increasing trust in systems is to let the system behave similar to the one who is operating it. Social science literature demonstrates that people are often drawn to others perceived as similar (Baumeister, 1998). Mimicry for example, is a tendency of imitating someone to behave similar to another, conscious or unconscious. In the unconscious form, some aspects of mimicry such as tone of voice, facial expressions, mood, and physical mannerism can be used to create a ‘chameleon effect’ which can enhance liking and strengthen bonds between people (even strangers) (Chartrand & Bargh, 1999). Furthermore, mimicry has been found to increase trust in a deal making situation with win-win potential (Maddux, Mullen, & Galinsky, 2008). The chameleon effect also has been tested in a virtual environment (Bailenson & Yee, 2005) where participants interacted with an embodied artificial intelligence agent mimicking the head movements of the participant, and was found more persuasive and likable than the non-mimicking agent, resulting in the ‘digital chameleon effect’. And other research suggests that using this digital chameleon effect in a virtual deal making situation could also lead to more trust in virtual agents (Verberne, Ham, Ponnada, & Midden, 2013).

Another way of increasing trust in systems is to make it look similar to the one who is operating the system. It has been shown that exposure frequency to a familiar human face influences preference for that face over other less familiar faces, which is called the ‘mere exposure effect’ (Zajonc, 1968). Having in mind people see themselves in reflective surfaces quite often (e.g. mirrors, windows), could it then be possible that a virtual agent that has facial similarities with a user can also increase trust? In experiments concerning facial similarity between voters and candidates during elections, it was shown that candidates morphed with images of the voters had a higher preference
because of their facial similarity with the voter (Bailenson, Iyengar, Yee, & Collins, 2008). In a series of three experiments regarding unfamiliar candidates, familiar candidates and a combination of both, results revealed that there are preferences for facially similar candidates. Another study shows the effect of facial similarity on trust (DeBruine, 2002). Here, a two-person sequential trust game was played by participants who competed against pictured opponents and were unaware that these opponents had digitally morphed faces. These morphed faces were a combination of the participant's own face and an unknown person. Participants trusted the morphed faces that resembled themselves more than they trusted other opponents. Another study using functional magnetic resonance imaging (fMRI) shows similar effects concerning neural responses to self-faces morphed with trustworthy or untrustworthy faces (Verosky & Todorov, 2010). Here, participants were shown their own faces morphed with a trustworthy, and untrustworthy face consisting of five morphing levels (20%, 40%, 50%, 60%, and 80%) and had to decide whether the morph looked like them or the other face. Even though the morphed faces of the two conditions were matched in terms of physical characteristics, participants were more likely to identify the trustworthy than the untrustworthy morphs as looking like the self. Another study examined whether a virtual agent with facial similar characteristics of the participant could enhance behavioral trust in technology (Bao et al., 2013). In this study, participants played two trust involved deal making games with a virtual facially similar or dissimilar agent that spoke with synthetic speech. Participants could either make decisions themselves or let the agent do it for them. In addition, they were only shown the performance outcome at the end of the experiment to keep the performance of the agent uncertain. However, a behavioral effect of giving more credits and routes to plan for the facially similar agent was not found. Contrary to before mentioned studies, results indicated a contrast effect of similarity on participants similar to the agent who reported less similarity. However, when the participant felt more similar with the facially similar agent, he was trusted and liked more than the facially dissimilar agent, and was rated as more competent. Although no behavioral effect was found, results suggested that the use of the facial similarity cue to enhance trust in a system could be successful.

Evidence indicates that similarity cues such as mimicry and facial similarity can influence trust in humans and seem to be capable of creating similar effects between humans and systems through the use of virtual agents. It might be possible that using similarity cues could eventually persuade the operator to hand over control to a system when manipulated by a facially similar agent. In order to successfully introduce the autonomous vehicle on the road more efficient, we need to know how, and how, facial similarity can play a role in persuading the driver to trust the system. However, we do not know how strong the effect of the facial similarity cue is in a driving context, or if one is willing to hand over control to a facially similar agent. This study will investigate whether trust in handing over control to different types of systems can be increased by using a virtual agent whose face is morphed with the face of the participant. This is tested on a behavioral level by participants' performance and on cognitive level by questionnaires. Here, we expect that a facially similar agent will be given more control than a facially dissimilar agent. Furthermore, we hypothesize that a facially similar agent will be trusted and liked more than a facially dissimilar agent. And if participants feel more similar with the facially similar agent, they will trust and like him more than a facially dissimilar agent.
2 Methods

2.1 Design and participants

Eighty one participants took part in this experiment (41 men and 40 women, average age = 22.62, SD = 5.917). The participants were randomly assigned to one of the two conditions of a single-factor, between-subjects design (agent: facially similar vs. facially dissimilar) with an equal men-women ratio for every condition (facially similar male/female= 19/21, facially dissimilar male/female = 21/20). Dependent measures consist of several behavioral trust measures and two questionnaires measuring trust and liking. The experiment lasted for approximately 45 minutes. Participants were paid €7.50 plus the bonus earned during the investment and route planner games. Outliers were excluded when they scored higher than two SD’s in two or more tasks or when they recognized the purpose of the experiment (3 participants), leaving a sample size of 78 (facially similar: 37, facially dissimilar: 41).

2.2 Materials

Photographs. Participants’ photographs were used for creating the morphed agent. Participants took their own photographs and submitted them considering the following criteria: frontal view, high resolution, color, no glasses, neutral expression, adequate lighting and no hair on front of the face. If low quality photographs were sent, a facially similar could not be produced and participants were placed in the facially dissimilar condition with a random gender matched morphed face (3 male and 8 female). The cover story for obtaining these pictures was the Rapid Serial Visual Presentation (RSVP) task (Raymond, Shapiro, & Arnell, 1992). Participants are presented with a sequence of rapid switching portrait photographs, including the one they have submitted, and have to detect when a given photograph. As the task is a cover up task, performance data is irrelevant for this research and is not analyzed.

Face morphing procedure. A digital morphing technique was used to create the virtual agents by combining the participants’ faces with a virtual default agent (fig.1). Participants see themselves mostly in reflective surfaces which are why photographs were horizontally flipped before morphing them. Digital morphs were created in FaceGen (version 3.5) where the tween function was used to morph the texture & shape of the virtual default agent with the participant’s face for 50% (Verosky & Todorov, 2010). Participants’ detail textures were also 50% blended. To disguise a bias towards bald men, a headband was added to minimize the effect of gender of the morph.

![Figure 1. Morphing the participant photo (left) with the default virtual agent (right) leads to a facially similar agent (center).](image-url)

1 Participants’ faces were obtained through instructions included in recruitment flyers where they had to send their photograph digitally (for the detailed instruction list, please refer to the appendix A).
**Morphed agent.** For the investment game, route planner game and driving scenario task, facially similar and facially dissimilar virtual agents were used as manipulation. A body was added to the head of the morphed agent. The agent had a natural eye blink\(^2\) and was called John. In the facially similar agent condition, participants were presented with an agent whose face was morphed with their own face; in the facially dissimilar agent condition, its face was morphed with another random same-gender participant.

**Driving scenarios.** Seven randomly assigned driving scenarios from the City Car Driving environment (version 1.2.5) were recorded with Fraps (version 3.5.99). Driving scenarios were constructed through a driving task analysis on basis of complexity and amount of risk (Fastenmeier & Gstalter, 1970, 2007). Seven driving scenarios (appendix C) representing difficulty levels from low risk and low complexity to high risk and high complexity are played in a random order (table 1). Each scenario starts with an accelerating vehicle and ends before it is clear what the outcome of the situation will be. Participants are able to let the vehicle be controlled by John, or regain control by pressing the spacebar at any time during the scenarios. The outcomes vary from stopping in front of a marked line on a test track at high speed to an emergency brake situation on the highway. To prevent a bias towards the braking performance of an autonomous vehicle, which can initiate a braking action faster, the tasks are also fit to ensure a human operator could bring the situation to a good end. Therefore, all scenario endings ensure that the video ends where participants also could react on time.

<table>
<thead>
<tr>
<th>Driving scenario</th>
<th>Environmental context</th>
<th>Classification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slalom</td>
<td>Closed test track</td>
<td>Low risk/ higher complexity</td>
</tr>
<tr>
<td>Start-stop</td>
<td>Closed test track</td>
<td>Low risk/ low complexity</td>
</tr>
<tr>
<td>Red traffic light</td>
<td>City (straight road, double lane)</td>
<td>Low risk/ low complexity</td>
</tr>
<tr>
<td>Tree on the road</td>
<td>Country road (corner, single lane)</td>
<td>High risk/ medium complexity</td>
</tr>
<tr>
<td>Crossing pedestrian</td>
<td>City (straight road, double lane)</td>
<td>High risk/ low complexity</td>
</tr>
<tr>
<td>Corners on test track</td>
<td>Closed test track (single lane)</td>
<td>Low risk/ medium complexity</td>
</tr>
<tr>
<td>Emergency brake highway</td>
<td>Highway with traffic (four lanes)</td>
<td>High risk/ high complexity</td>
</tr>
</tbody>
</table>

**2.2.1 Dependent measures**

**Investment game.** The single agent investment game measures behavioral trust (Berg, Dickhaut, & McCabe, 1995). Both the participant and John were given 10 credits. Participants can choose how many credits they give to John. For every given credit, John received this amount tripled and decided how many he would give back to the participant. No feedback was given about the amount of credits earned to remain uncertainty in the performance of John. Measuring behavioral trust is done by the number of credits given to the agent. The higher the amount of credits was given to John, the more they trust him.

---

\(^2\) Eye blinking function added in Peoplemaker to implement in the Vizard Complete Character set. For a detailed instruction for constructing the agent, please refer to appendix B.
Route planner game. Behavioral trust was also measured in the route planner game. Here, participants were given 20 credits. Participants were given 10 routes to plan with two choices: to let John plan the route, or not. If the participant chose not to let John plan the route, one credit was lost. If the participant chose to let John the plan the route, two credits were lost. If the planned route happened to be the fastest route, then participants would get four credits back for that route. Every route given to John could lead to a potential gain of three credits (as in the investment game). No feedback was given about the performance outcome. The amount of routes participants’ decided to give to John is the behavioral measure of trust. The more routes are given to John, the more he is trusted. Both trust and route planner games involved real currency and every credit left at the end of the games were worth €0.05. The exact value of a credit was unknown to the participants and they were told that the credits left at the end would determine their monetary bonus.

Trust questionnaire. Trust in John was measured by a questionnaire (Jian, Bisantz, Drury, & Llinas, 1998) containing 12 questions with a seven-point Likert scale (1 = “totally disagree”, 7 = “totally agree”) per question. Answers to these questions were averaged to get a reliable measure of trust (Cronbach’s Alpha: 0.88). A higher score represents a higher trust level in John.

Liking. Liking was measured using the partner ratings items (Guadagno & Cialdini, 2002) of 13 different dimensions (approachable, confident, likable, interesting, friendly, sincere, warm, competent, informed, credible, modest, honest and trustworthy). A seven-point Likert scale (1 = “totally disagree”, 7 = “totally agree”) per question measures liking of John. Analysis is done by averaging the score; the higher the score, the higher the liking in John (Cronbach’s Alpha: 0.87).

Driving task. In the driving task, behavioral trust was also measured. In each driving scenario, John controls the vehicle. Participants are instructed to press the spacebar when they feel they need to regain control over the vehicle while watching the driving scenario. Each scenario ends on a time-critical moment where it is uncertain what would have happened if John remained control or the participant. After each video, trust in the agent on a cognitive level is measured by several, seven-point Likert scale, trust related questions. These concerns if John or the participant could safely bring the situation to an end, how common and how difficult each driving scenario was, and how much risk was involved in the scenario.

Self-other overlap. Self-other overlap with John was measured through the Inclusion of the Other in the Self-scale through both a pictorial and a continuous version of the scale (Aron, Aron, & Smollan, 1992). The pictorial version consist of seven pairs of circles, ranging from no overlap to a maximum overlap, in which the participant has to choose which pair represents their relationship with John the best. In the continuous version, only two circles are presented in which one represents the participant and the other John. Participants have to click on the circle that represents them and drag it closer to the agent’s circle, hereby possibly overlapping each other depending on how they see their relationship with John. Both measures were standardized and averaged to compute a reliable measure of self-other overlap (r = 0.87). Higher scores indicate more overlap with John.
2.2.2 Exploratory measures

Several exploratory measures were included in the experiment to find possible underlying mechanisms or confounding variables for our results.

*Impression about John.* Participants are introduced to John at the start of the experiment. This first encounter is where participants start to form an impression about John. Gender, age, trust, liking, health and attractiveness questions are asked in the beginning of the experiment about John to see if they could confound/interfere with final results in the experiment.

*Expected credits.* In both the trust and route planner games, expected credits were measured by a single item question (“How many credits do you expect to get from the game you’ve just played?”)

*Explicit self-esteem.* Explicit self-esteem is a self-reflection on participants’ feelings and was measured using the Rosenberg Self-Esteem Scale (Rosenberg, 1965) in Dutch. Ten, four point Likert scale questions were asked to measure explicit self-esteem of John (1 = “strongly agree”, 4 = “strongly disagree”). Five items are positively worded statements and five negatively. Answers to these questions were averaged (Cronbach’s Alpha: 0.87), a higher score represents more explicit self-esteem.

*Implicit self-esteem.* Implicit self-esteem was measured using a self-esteem Single-Target Implicit Association Test (Bluemke & Friese, 2008). This is an implicit measure to assess automatic affective reactions through self-relevant (words displayed as: me, my, myself, their first and last name), positive and negative words categorized as positive or negative. Self-positive and self-negative targets (one on the left of the screen and one on the right) are controlled by two response keys on opposite sides of the keyboard. When the reaction time of the self-positive is shorter than the self-negative, it implies a positive self-esteem and is vice versa for the self-negative. Larger differences imply a stronger self-esteem.

*Perceived risk.* Five, seven-point Likert scale questions were asked to measure perceived risk of John (1 = “totally disagree”, 7 = “totally agree”). Answers to these questions were averaged (Cronbach’s Alpha: 0.68); the higher the score, the higher the perceived risk for John.

*Perceived competence.* Perceived competence of John was measured with three questions with a seven-point Likert scale (1 = “totally disagree”, 7 = “totally agree). Answers to these questions were averaged (Cronbach’s Alpha: 0.72); the higher the score, the higher the competence.

*Acceptance.* Acceptance of John was measured with nine, five-point scale, questions addressing whether John functioning as a route planner in a vehicle was ‘useful/useless’, ‘pleasurable/unpleasant’, ‘bad/good’, ‘like/dislike’, ‘effective/unnecessary’, ‘annoying/pleasant’, ‘helpful/worthless’, undesirable/desirable’ and ‘alerting/narcotic’ (Laan, Heino, & Waard, 1997). The items can be divided into two scales, one denoting the usefulness of the system and the other satisfaction. Answers to these questions were averaged for both subscales (Cronbach’s Alpha: 0.82 for all nine items, 0.72 for usefulness and 0.82 for satisfaction); the higher the score, the higher the usefulness and/or satisfaction.

*IQ.* Participants were asked to estimate John’s IQ with a single item question: “The average IQ of a human is 100. How high would you estimate the IQ of John?”

*Exploratory performance measures.* Several exploratory performance measures were measured to explore whether participants’ performance could relate to trust and liking. In the trust and route planner games, decision time was measured (hovering time above answer(s)). Additionally,
the difficulty of the route (simple vs. complex) is measured to indicate whether participants give control to the agent in more complex, or simple routes.

**Gender differences.** Our default agent used to create the morphed agent is of male gender. As both male and female participants participated in the experiment, gender has been taken into account as factor to find possible gender differences.

**Comments.** After the driving scenarios, the participant has the ability to write down any thoughts and comments about their overall experience or in specific about a task.

### 2.3 Procedure

Prior to the experiment, participants were asked to send in a photograph of them for use during the experiment. At the start of the experiment, participants were welcomed and, after signing an informed consent form (see appendix D), seated in a separate cubicle in front of a computer. Participants first completed the RSVP task (Raymond et al., 1992), the task used as bogus story for the experiment. Then, John was presented on the right side of the screen and participants were asked questions to give an impression about John. John stayed displayed while participants were explained about the investment game and its rules. After completion, questions were asked about the expected credits. The route planner game started with John at the same position as before accompanied with an explanation. After completion of the route planner game, they were asked to complete the trust, liking, perceived risk, perceived competence, acceptance, self-other overlap, IQ measures, and competence of the agent. Before starting the driving scenario task, participants watched an instruction video on what they could expect in the driving scenario task. During the task, participants were asked questions about the specific scenario and the interaction with John. When all driving scenarios ended, participants were asked to give comment on the driving scenarios and overall comments on the experiment. After completion of the experiment, the participant was asked for demographics. Furthermore, they were informed about their performance during the experiment which determines the earned bonus. After payment, participants were debriefed and were told about the actual use of the photographs, informed about the goal of the experiment, and thanked for participation.
3 Results

3.1 Manipulation check
In their first encounter with the morphed agent, participants were asked questions with respect to feelings about John to exclude a first impression difference between conditions. None of the answers showed a significant effect of the agent condition.

3.2 Main analyses
To check whether participants in the facially similar condition handed over control more than in the facially dissimilar condition, a one-way MANOVA was used with the agent condition as the independent variable and trust game decision, route planner game decision, and driving scenario decision as the dependent variables. None of the behavioral effects were significant. In the investment game, there was no significant main effect of agent, $F(1, 77) = 0.298$, $p < 0.589$, $\eta^2_p = 0.004$. Participants who interacted with a facially similar agent did not give him more ($M = 5.73$, $SD = 2.79$) credits than those who interacted with a facially dissimilar agent ($M = 5.39$, $SD = 2.70$).

In the route planner game, there was also no significant main effect of agent, $F(1, 77) = 0.126$, $p < 0.724$, $\eta^2_p = 0.002$. Participants that interacted with a facially similar agent did not give him more ($M = 5.97$, $SD = 1.74$) routes than those that interacted with a facially dissimilar agent ($M = 6.12$, $SD = 1.95$). And in the driving scenarios, there was no significant main effect of agent in all of the scenarios, with all $F$’s < (1, 77) = 0.832 and all $p$’s > 0.365. Participants that interacted with a facially similar agent did not give him more control than those who interacted with a facially dissimilar agent. These results indicate no main effect of facial similarity and suggest participants would not give more control to the morphed agent if he looked more similar to them.

A one-way MANOVA was used with agent condition as the independent variable and trust and liking as dependent variables. Results suggested that participants in the facially similar condition trusted John more ($M = 4.48$, $SD = 0.91$) than in the facially dissimilar condition ($M = 4.05$, $SD = 0.78$), $F(1, 77) = 5.104$, $p < 0.027$, $\eta^2_p = 0.063$. Furthermore, participants in the facially similar condition also liked John more ($M = 4.62$, $SD = 0.84$) than in the facially dissimilar condition ($M = 4.169$, $SD = 0.66$), $F(1, 77) = 7.085$, $p < 0.009$, $\eta^2_p = 0.085$. This is in line with our hypothesis that a morphed agent is liked and trusted more if he looks more similar to one self.

Mediation analyses. To check if increased self-other overlap would mediate the effect of facial similarity on trust and liking of the agent, a mediation analysis (on the basis of Baron & Kenny, 1986) was conducted to reveal direct (Path c) and indirect effects (Path a and b) of facial similarity on trust and liking (Appendix E for mediation models). The Sobel test (Sobel, 1982) revealed a significant indirect effect for trust (Sobel $z = 2.15$, $p < 0.03$, $\eta^2_p = 0.216$) and liking (Sobel $z = 2.15$, $p < 0.03$, $\eta^2_p = 0.193$). The initial effect of agent condition for trust and liking (Path c) becomes non-significant after controlling for self-other overlap (Path c’). Here we can confirm our expectation that when participants felt similar to John, they trusted and liked him more.
3.3 Exploratory analyses

Several one-way ANOVA’s with the agent condition as independent variable were conducted where impressions about John, expected credits, self-other overlap, explicit-and implicit self-esteem, perceived risk, perceived competence, acceptance, perceived IQ of John and other exploratory performance measures were used as dependent variables.

**Expected credits.** Participants were asked how many credits they expected have left after the investment game and route planner game. For the investment game, there was no significant main effect of agent, $F(1, 77) = 0.039, p < 0.844, \eta^2_p = 0.001$. Participants expected the same amount of credits back from a facially similar agent ($M = 10.92, SD = 1.23$) as from a facially dissimilar agent ($M = 10.59, SD = 1.16$). For the route planner game, results also suggest no significant main effect of agent, $F(1, 77) = 0.375, p < 0.542, \eta^2_p = 0.005$. Participants gave the same amount of routes to a facially similar agent ($M = 4.24, SD = 0.26$) as to a facially dissimilar agent ($M = 4.46, SD = 0.25$).

**Self-other overlap.** Results showed a significant main effect of agent, $F(1, 77) = 4.593, p < 0.025, \eta^2_p = 0.064$, where participants in the facially similar condition felt more ($M = 0.255, SD = 1.038$) similar to John than those who were facially dissimilar ($M = 0.231, SD = 0.843$).

**Explicit-and implicit self-esteem.** Results suggest no significant main effect of agent, $F(1, 77) = 1.766, p < 0.505, \eta^2_p = 0.023$. Participants experienced the same self-esteem in the facially similar condition ($M = 5.130, SD = 0.88$) as in the facially dissimilar condition ($M = 5.407, SD = 0.96$).

**Perceived risk.** There is no significant main effect of agent, $F(1, 77) = 0.448, p < 0.505, \eta^2_p = 0.006$. Participants indicated no difference in perceived risk between the facially similar condition ($M = 4.449, SD = 0.498$) and the facially dissimilar condition ($M = 4.527, SD = 0.531$).

**Perceived competence.** A significant main effect was found for perceived competence of the agent, $F(1, 77) = 5.65, p < 0.02, \eta^2_p = 0.069$. Here, participants found the agent more ($M = 4.38, SD = 0.98$) competent in the facially similar condition than in the facially dissimilar condition ($M = 3.85, SD = 0.997$).

**Perceived IQ of the morphed agent.** There is no significant main effect of agent, $F(1, 77) = 0.865, p < 0.355, \eta^2_p = 0.011$. Participants perceived the IQ of the morphed agent similar in the facially similar condition ($M = 105.3, SD = 12.15$) as in the facially dissimilar condition ($M = 102.8, SD = 11.54$).

**Acceptance.** There was no main significant effect of agent in the first acceptance subscale, $F(1, 77) = 0.509, p < 0.478, \eta^2_p = 0.007$. Participants interacting with a facially similar agent found the system as useful ($M = 4.96, SD = 0.65$) as those who interacted with a facially dissimilar agent ($M = 4.85, SD = 0.68$). A marginally significant effect of agent was found on the second subscale of acceptance, satisfaction ($F(1, 77) = 3.47, p < 0.066, \eta^2_p = 0.044$). Here, participants in the facially similar condition found the system more ($M = 4.48, SD = 0.76$) satisfying than in the facially dissimilar condition ($M = 4.19, SD = 0.612$).

**Gender differences.** Gender has been taken into account to check for gender differences but only a marginally significant effect was found on trust in the trust questionnaire where women trusted John more ($M = 4.43, SD = 0.86$) than men ($M = 4.07, SD = 0.84$), $F(1, 76) = 3.44, p < 0.067, \eta^2_p = 0.043$. 
3.4 Participants’ performance in the driving scenarios

Driving scenarios. To check for an agent condition or gender effect, a logistic regression analysis was performed with agent condition and gender as independent variables and driving scenario as dependent variable. However, no significant effect was found with all p’s > 0.299. According to the main analysis, participants who were facially similar to John did not let him control the vehicle more than facially dissimilar participants.

Participants were given the opportunity to provide comments on the driving scenarios. Generally, their perception of John’s driving behavior was that he drove non-responsible. Key terms that describe this driving behavior were ‘reckless’, ‘too fast’, ‘aggressive’ and ‘uncontrolled’. His braking and accelerating behavior provided the basis for these reactions that led to an uncertainty about whether he would brake on time, or would slow down appropriately. Therefore, participants commented John was not capable of bringing the situation to a good end as a result of his driving behavior. To check if these comments could have an underlying reason, an exploratory analysis on the percentage of times the participant wanted to regain control was performed. Results indicate that John’s distinctive accelerating and decelerating behavior seem to have had an effect on participants’ behavior to regain control over the vehicle. In particular the scenarios where the vehicle accelerated to, or decelerated from, a higher velocity showed a percentage between 70.5-75.6% in regaining control compared to low velocity scenarios where a 5.1-42.3% range was measured (table 2). The start-stop scenario resulted in 61.5% of the participants regaining control where a short driving distance and velocity were realized compared to a larger distance and higher velocity in other scenarios. Furthermore, the scenarios with high percentages of regaining control involved a non-test track, city environment. These results suggest that John’s driving behavior was indeed inappropriate enough to regain control over the vehicle.

Table 2. Percentage of times participants regains control in driving scenario task per scenario.

<table>
<thead>
<tr>
<th>Driving scenario</th>
<th>Button presses (%)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Slalom on test track</td>
<td>5.1</td>
</tr>
<tr>
<td>Corners on test track</td>
<td>24.4</td>
</tr>
<tr>
<td>Tree on the road</td>
<td>42.3</td>
</tr>
<tr>
<td>Start-stop on test track</td>
<td>61.5</td>
</tr>
<tr>
<td>Crossing pedestrian</td>
<td>70.5</td>
</tr>
<tr>
<td>Emergency brake highway</td>
<td>74.4</td>
</tr>
<tr>
<td>Red traffic light</td>
<td>75.6</td>
</tr>
</tbody>
</table>
4 Discussion

This study investigated whether trust in handing over control to a system could be increased by using a virtual agent whose face is morphed with the face of the participant. We expected that a participant would give more control to a facially similar agent than to a facially dissimilar agent. We also expected this facially similar agent to be trusted and liked more than a facially dissimilar agent and that if participants feel more similar with the facially similar agent, they will trust and like him more than a facially dissimilar agent. We have found no behavioral evidence that supports our main hypothesis which is in line with earlier research findings (Bao et al., 2013). However on cognitive level, results of the questionnaires indicated that the facially similar agent had higher trust and liking scores than the non-facial similar agent which could mean that our expectations were confirmed in terms of trust and liking of the morphed agent. This finding was strengthened with evidence that when participants felt more similar to the facially similar agent, they trusted and liked him more. Furthermore, participants who looked more like the facially similar agent also perceived him as more competent. However, as none of the behavioral measures provided support for our main hypothesis, it suggests that currently there is no indication one would hand over control to a system (either in a game or autonomous vehicle) when manipulated by a facially similar agent interface. Results indicate that an initial phase of trust (on cognitive level) in a system was activated, but not enough to actually persuade someone to hand over control to that system. There are several reasons that could explain why this didn’t happen.

Comparing our results with other similarity research on trust behavior reveals mixed results on both behavioral and cognitive level (Bao et al., 2013; Verberne et al., 2013). On behavioral level, only Verberne’s similarity cue, mimicry, on route planner decision was found significant where participants gave more routes to the more similar mimicking agent. All other mimicry and facial similarity results of the studies did not find any behavioral effect. On cognitive level, mixed results have been found on trust and liking of the agent and could possibly have been more consistent if the non-human attributes used in those studies such as voice and appearance, were the same for all. This in particular seemed to have an effect on self-other overlap where the use of a synthetic voice in the research of Bao et al could have resulted in participants feeling less similar if the agent is too artificial. In our experiment, self-other overlap was asked after the first two games. However, the morphed agent in the third task, concerning the driving scenarios, was found a non-responsible driver which could have influenced self-other overlap if we had asked afterwards as well. Furthermore, we could argue that feeling similar to an agent controlling a game is different than an agent controlling a physical vehicle in motion. In what way is the vehicle similar to the morphed agent if he looks more like you and how will this affect the way you feel similar to the agent? The vehicle is more tangible than the other games, and the agent should represent the vehicle as similar entity. Future research could focus on further investigating self-other overlap in a driver-agent-vehicle setting and how this is influenced by aspects such as driving behavior. Is feeling similar to the morphed agent the same as feeling similar as the vehicle you are in?

The findings on this, and the other studies, suggest that a single cue as manipulator is not enough to realize a behavioral effect. When a person trusts another person based on the trust cue similarity, several aspects of similarity are involved that contribute to an enhanced trust relationship. Similar attitudes, familiarity, mimicry, and even a similar date of birth could contribute to increase trust in a person with similar characteristics (Pelham, Carvallo, & Jones, 2005). Engaging in an interaction with our morphed agent was limited as it communicated only through text on display. Using synthetic speech has shown to be of negative influence on trust (Bailenson & Yee, 2005; Bao et al., 2013) and natural speech response is quite the technical challenge to accomplish. In the experiment, the encounter with the agent might seem similar to the situation where a person engages in an interaction without any response, possibly creating the impression of a distant, non-interested attitude towards the participant. As has been shown in earlier research (Vries, 2004),
system trust mediates the relation between errors and handing over control to a system. Perhaps the uncertainty of the morphed agent’s performance in combination with the agent being ‘too artificial’ and the lack of more natural interaction increased the effect of our facial similarity manipulation, but reduced the behavioral trust effect as facial similarity is just one of several trust cues. Why should an artificial agent be given control if it looks similar to a human, but doesn’t react like one and we can’t see how it performs? For obvious reasons, direct system performance feedback would disturb our manipulation as system errors decrease trust. Furthermore, when performing the tasks, attention is focused on the task itself rather than looking at the agent. Perhaps participants didn’t look frequent enough at the morphed agent as earlier research indicated that the mere exposure effect leads to higher trust. Future research could therefore make use of eye tracking technology to track participants’ looking behavior. Also, future research could focus on enhancing better interactive behavior by an agent and integration of more similarity cues to make it less artificial and to increase system trust.

We have found little to none gender differences in our results even though the default agent used to blend the participant with was of male gender and the morphed agent had a head band and was bald, which are more common characteristics for men. Further evidence showed no gender difference in self-other overlap despite these characteristics. This doesn’t mean we have to conclude that there are no gender effects. Gender differences concerning the trust questionnaire didn’t show that much difference where women even tended to trust the morphed agent more than men. But literature points out that men and women can behave different when playing risky games such as the investment game showing differences in trust behavior and expected return (Buchan, Croson, & Solnick, 2008). Future research should therefore always take into account the possibility of gender differences when it concerns trust related games.

The quality of photographs sent by the participants varied largely despite receiving a photo instruction list (low resolution, partial shadow on the face). This influenced the image quality of the morphed agent and could possibly lead to biased recognition detection towards higher quality photographs as characteristics such as texture and face distortion (due to low quality camera lenses) varied. The morphed agent is a blend between participant and default agent. It was corrected through detail textures and differences between participant photo qualities could have led to inconsistencies on specific facial characteristics and recognition. In future research, better control for image quality is recommended to maintain consistency between morphed agents.

Investigating how a driver could hand over control to an autonomous vehicle by trust manipulation is a challenge. In this study, recorded driving scenarios have been used to investigate how participants would respond to trust manipulation when watching them on a computer screen. In these scenarios, participants were asked to indicate if they would like to regain control over the vehicle when it was driven by John. We can already argue that these scenarios presented in the experiment are not representative for driving in a real environment. Furthermore, since the morphed agent in the driving scenarios was always in control over the vehicle, participants couldn’t compare their driving performance in the given environment as they never had control over the vehicle to evaluate their own driving performance. Therefore, asking them whether they would regain control as behavioral measure might seem invalid as they could never have this control. This gave us more control over the driving scenario execution but is low in validity as no active driving was involved. When a driver is given the possibility to hand over control to a vehicle, or regain it, driver control needs to be present. This resulted in participants experiencing driving as a passenger instead of a (co)driver where driving behavior aspects such as workload, attention and driver stress that are normally involved in the driving task, become irrelevant. If participants could have driven in the virtual environment, they could have better compared performance and decide whether the virtual agent should take over the driving task or not. While John’s overall driving performance was uncertain (participants didn’t know if John would bring the situation to a good end), participants
generally commented that the John would accelerate too quickly and brake too late (or felt he would not brake at all) and evaluated his driving behaviour negatively. The driving scenarios were recorded simulation drives where one of the experimenters performed, with his own driving style, the driving scenarios. Perhaps if our morphed agent would have a similar driving style as the participant, we could argue that this results in an effective similarity cue that contributes to enhanced trust. However, when one already specifies their driving style as inadequate or unsafe, a similar driving style of the morphed agent could result in worse performance.

Currently, autonomous vehicles such as the autonomous Google-car reach up to a level three automation “Limited Self-Driving Automation” (Table 3) where the driver can still regain control (Aldana, 2013). This means that a driver is still necessary to perform the driving task. This task consists of conditions with varying task demand where decisions and performance are affected by driver stress factors (Matthews, 2002). Driving behavior is determined in how cognitive stress processes are affected by personality factors (dislike of driving, aggressiveness and possibly attitude towards assistance systems) and environmental stress factors (high workload, busy traffic) and results in behavior in how to cope with the situation. In our driving scenarios, only environmental factors were controlled, but no personality factors that are present in driving were involved. This could have affected their decision making during the driving scenarios as we do not know how personal driver stress interacted with the facial similarity cue. Future research could take into account these personality factors and perhaps more clear distinctions could be found on who is more prone to trust an autonomous system.

Table 3. Vehicle automation levels according to NHTSA (Aldana, 2013).

<table>
<thead>
<tr>
<th>Automation level</th>
<th>Control</th>
</tr>
</thead>
<tbody>
<tr>
<td>Level 0: No-automation</td>
<td>The driver is in complete and sole control of the primary vehicle controls – brake, steering, throttle, and motive power – at all times.</td>
</tr>
<tr>
<td>Level 1: Function-specific automation</td>
<td>Automation at this level involves one or more specific control functions. Examples include electronic stability control or pre-charged brakes, where the vehicle automatically assists with braking to enable the driver to regain control of the vehicle or stop faster than possible by acting alone.</td>
</tr>
<tr>
<td>Level 2: Combined function automation</td>
<td>This level involves automation of at least two primary control functions designed to work in unison to relieve the driver of control of those functions. An example of combined functions enabling a Level 2 system is adaptive cruise control in combination with lane centering.</td>
</tr>
<tr>
<td>Level 3: Limited self-driving automation</td>
<td>Vehicles at this level of automation enable the driver to cede full control of all safety-critical functions under certain traffic or environmental conditions and in those conditions to rely heavily on the vehicle to monitor for changes in those conditions requiring transition back to driver control. The driver is expected to be available for occasional control, but with sufficiently comfortable transition time. The Google car is an example of limited self-driving automation.</td>
</tr>
<tr>
<td>Level 4: Full self-driving automation</td>
<td>The vehicle is designed to perform all safety-critical driving functions and monitor roadway conditions for an entire trip. Such a design anticipates that the driver will provide destination or navigation input, but is not expected to be available for control at any time during the trip. This includes both occupied and unoccupied vehicles.</td>
</tr>
</tbody>
</table>

If we want to enhance trust in autonomous systems we have to think about the further consequences when we give full control to automated vehicles and when we need to regain control in terms of safety. These transitions bring even more challenges when drivers’ attention, situation awareness, and resulting driving skill need to be at a certain level to be capable in taking over the driving task in various low-and high demanding situations. By allocating additional visual attention to a virtual agent interface in a vehicle during driving, distraction from the driving environment increases which could lead to accidents when control is regained. Overreliance of the automated system could also lead to a decreased performance in maintaining attention. And if in stressful, high workload situations control needs to be regained, a loss of situation awareness in the automated vehicle could be the result (Stanton & Young, 2000). In several studies it is already shown that these factors impair drivers in taking over control from automated vehicles (Level 2 Combined Function...
Automation, according to NHTSA classification) in emergency situations (de Waard, van der Hulst, Hoedemaeker, & Brookhuis, 1999; Knight, 2013a; Stanton & Young, 1998). This is further emphasized by Clifford Nass, co-director of Stanford University’s Center for Automotive Research:

“The first generations (of autonomous cars) are going to require a driver to intervene at certain points. It turns out that may be the most dangerous moment for autonomous vehicles. We may have this terrible irony that when the car is driving autonomously it is much safer, but because of the inability of humans to get back in the loop it may ultimately be less safe.” (Knight, 2013b)

Based on the challenges of persuading one to trust an autonomous system, we could argue that the trust relationship between human and autonomous vehicle should be more carefully examined by not only looking at similarity cues to persuade one to give control, but should also focus on a mutual relationship of trust instead of a one way trip into autonomy. When we give control to an autonomous vehicle, and at some point need to regain control, the system should also be aware that we are indeed able to safely regain that control at that moment.

To conclude, the current study indicates some evidence that manipulating facial similarity to increase trust in a morphed agent could be successful. However, facial similarity is one of several cues that can be used in increasing trust in an automated system. And as with trust between humans, only one similar characteristic is not enough to put one’s safety the hands of another in potential dangerous situations. Combining similarity cues such as mimicry, shared goals, and driving performance could contribute to the point where humans trust a system enough to let them control their vehicle. In terms of valid representations for the real world, we did not make use of a driving simulator or an autonomous test vehicle in our experiment. However the findings of this experiment can be taken as a more fundamental basis before testing in higher fidelity experiments and these current results give a promising basis.
5 Bibliography


Appendix A: Photograph instruction list

- Create a FaceGen face from one or more photos.
- A frontal image is required. Left and right profile images are optional
- **Photo Guidelines**
  - The most important step is to take good photos. To ensure good results, you must follow these guidelines:
    - **Essential:**
      - Faces must have the mouth closed and be in the neutral (relaxed) expression.
      - Eyes must be open and looking straight ahead.
      - Faces must be about 12 years of age or older.
      - The entire face must be in the photo.
      - Flash lighting must be used, and the face must not be otherwise brightly lit.
      - Images must be in color.
    - **Recommended:**
      - Glasses should be removed.
      - Hair should not cover the forehead or any part of the face.
      - The camera should be at least 3 feet away from the face.
      - The face should be at least 500 pixels high in the image.
      - In the frontal shot, your chin should slightly elevated as if you’re looking just above the camera.
      - Focus your eyes on something just above the camera, rather than into the distance, to avoid a spacey look.
    - **OK:**
      - Facial hair is OK.
      - flashes on both sides of the camera can be used.
      - Flash diffusers can be used.
    - **Bad:**
      - The face should not be painted (makeup is OK).
      - Avoid taking photos outdoors in daylight.
      - Drawings of faces may not yield good results.
  - Save your photos in the JPEG (JPG), BMP, TIFF (TIF) or TGA file formats.
Appendix B: Instruction list for creating the morphed agent

1. Gather photo’s of participant
   - Put the photos of all the participants in a folder you name Photos unflipped. Also create a folder with the name Photos flipped.

2. Flip photos of participants
   - Open ImageBatch
   - Input directory: Photos unflipped
   - Output directory: Photos flipped
   - Operation: flip -> horizontal -> start

3. Create FaceGen faces of participants
   - Open FaceGen Modeller
   - Click PhotoFit tab -> next
   - Load frontal image from Photos flipped -> next
   - Assign feature points (green markers) in picture -> next
   - Preserve facial hair in detail texture -> start now
   - Wait for FaceGen Modeller to finish PhotoFit
   - Model -> Change Model Parts -> Hair: SportHairBandStriped in ‘Show these parts’
   - File -> save -> \Fg faces unmorphed\SubjectX.fg

4. Extract detail textures of FaceGen faces
   - Run ‘Detail textures improved.bat’ in \Fg faces unmorphed
   - For every .fg file in that folder, a detail_FILENAMEFG.jpg will be generated. These are the detail textures that need to be blended.

5. Blend detail textures
   - Open Photoshop
   - File -> open detail_SubjectX.jpg
   - Select all (ctrl + a) & copy (ctrl + c)
   - File -> open default_text_big.jpg
   - Paste (ctrl + v)
   - Set opacity of layer 1 to 50%
   - Layer -> Merge down (ctrl + e) or Layer -> Flatten Image
   - File -> Save as -> C:\Users\USERNAME\appData\Roaming\FaceGen\Modeller3\Detail\detail_SubjectX_50%.jpg

6. Blend FaceGen faces
   - Re-start Facegen Modeller
   - Open SubjectX.fg
   - Click Tween tab
   - Load target -> default.fg
   - Make sure that Sync lock is checked, then highlight one of the two symmetry sliders on the left (S/T), but don’t change the sliders with the mouse
   - Press pagedown 5 times (10% change per press, so now slider is on level ‘In between’)
   - Select detail texture detail_SubjectX_50%.jpg
   - File -> Export -> \Fg faces morphed\SubjectX.obj
7. **Create Vizard head with morphs**

- **Start Peoplemaker**
- **File -> Open... -> Open File -> OK**
- **Click on Vizard Face Files (*.vzf) and change to All files (*.*)**
- \fg faces morphed\SubjectX.obj
- The head will be in the wrong position, but don’t worry, will get to that in a minute.
- **File -> Open... -> Create Morph -> OK**
- **Click on Vizard Face Files (*.vzf) and change to All files (*.*)**
- Open SubjectX_ModifierBlinkLeft.obj (the head will turn yellow)
- **Tools -> Generate morph target (the head is not yellow anymore)**
- The blink left morph is now added to the head
- **File -> Open... -> Create Morph -> OK**
- Open SubjectX_ModifierBlinkRight.obj (the head will turn yellow again)
- **Tools -> Generate morph target (the head is not yellow anymore)**
- The blink right morph is now added to the head
- **Now to get the head in the correct position (facing us)**
- **Click ‘Turn the head 90 degrees to the right’ twice**
- **Click ‘Turn the head 90 degrees upward’ once**
- **Now to adjust the size of the head for Vizard**
- **Click ‘Automatically scale the head to an ideal size’**
- It looks like your face is gone, but don’t worry! Press the spacebar, and peoplemaker will zoom automatically to make your face visible again.
- **Now to compute the neck vertices**
- **Tools -> Compute neck vertices (head becomes all green)**
- **Now comes the tricky part: selecting the neck vertices**
- turn the head 90 degrees to the right
- zoom with the mouse scroll and position the head with the right mouse button to get a clear view of the end of the neck
- **Click ‘Switch to vertex select mode’**
- Now, you have to draw a ‘lasso’ around all the green dots at the edge of the neck (and only these)
- **Tools -> Keep selected neck vertices**
- **Click ‘Switch to navigation mode’ to see if only the green dots at the edge of the neck are selected.**
- If you have too much green dots:
  - **Click ‘Switch to vertex select mode’**
  - Lasso around the green dots you want to remove
  - **Tools -> Discard selected neck vertices**
- If you missed a few green dots:
  - **Click ‘Switch to vertex select mode’**
  - Lasso around the dots you missed
  - **Tools -> Add to neck vertices**
- If you make a mistake, you can always go back with **Tools -> Compute neck vertices to select all green dots and try to select the neck vertices again**
- When you’re satisfied with the results, press the spacebar and lick ‘Turn the head 90 degrees to the right’ three times to get the head facing you again.
- **File -> Save as... -> \Faces\SubjectX\SubjectX.vzf**
Move files from \Faces\SubjectX: to Faces\SubjectX:
- SubjectX_eyeL_hi.jpg
- SubjectX_eyeR_hi.jpg
- SubjectX_skin_hi.jpg
- SubjectX_sock.jpg
- SubjectX_SportHairBandStriped.jpg
- SubjectX_teethLower.jpg
- SubjectX_teethUpper.jpg
- SubjectX_tongue.jpg

8. **Testing Vizard faces with morphs**
   - Open Vizard
   - File -> Open... -> \Vizard faces\Test blinking Vizard face.py
     Change in line 10: ‘Testface.vzf’ to ‘SubjectX.vzf’
     Run code to test blinking morphed head in Vizard
Appendix C: Driving scenarios

This appendix provides a brief overview of the driving scenario videos in type, length, environment, risk and complexity. These driving scenarios have all been randomized during the experiment.

**Driving scenario: Slalom**

<table>
<thead>
<tr>
<th>Length:</th>
<th>00:00:09</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environment:</td>
<td>Closed test track</td>
</tr>
<tr>
<td>Risk/complexity:</td>
<td>Low risk/higher complexity</td>
</tr>
</tbody>
</table>

**Driving scenario: Start-stop**

<table>
<thead>
<tr>
<th>Length:</th>
<th>00:00:07</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environment:</td>
<td>Closed test track</td>
</tr>
<tr>
<td>Risk/complexity:</td>
<td>Low risk/ low complexity</td>
</tr>
</tbody>
</table>

**Driving scenario: Traffic light**

<table>
<thead>
<tr>
<th>Length:</th>
<th>00:00:08</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environment:</td>
<td>City (straight road)</td>
</tr>
<tr>
<td>Risk/complexity:</td>
<td>Low risk/ low complexity</td>
</tr>
</tbody>
</table>
### Driving scenario: Tree on the road

| Length:  | 00:00:10 |
| Environment: | Country road (corner) |
| Risk/complexity: | High risk/ medium complexity |

### Driving scenario: Crossing pedestrian

| Length:  | 00:00:12 |
| Environment: | City (straight road) |
| Risk/complexity: | High risk/ low complexity |

### Driving scenario: Corners on test track

| Length:  | 00:00:03 |
| Environment: | Closed test track |
| Risk/complexity: | Low risk/ medium complexity |
Driving scenario: Emergency brake highway

<table>
<thead>
<tr>
<th>Length:</th>
<th>00:00:10</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environment:</td>
<td>Highway with traffic</td>
</tr>
<tr>
<td>Risk/complexity:</td>
<td>High risk/ high complexity</td>
</tr>
</tbody>
</table>
Appendix D: Informed consent

INSTEMMING ONDERZOEKSDEELNAME

Human Technology Interaction, Faculteit IE&IS, Technische Universiteit Eindhoven

Dit formulier is bedoeld om u te informeren over de werkwijze van het onderzoek ‘buddy’ bij de onderzoeksgroep Human Technology Interaction, en om uw toestemming te vragen voor deelname.

Deelname aan dit onderzoek is geheel vrijwillig. Als u tijdens een zitting van uw deelname aan het onderzoek af zou willen zien, om welke reden dan ook, kunt u dat op ieder moment doen. Als u aarzelt over deelname of vragen heeft over het onderzoek, kunt u die altijd stellen aan de proefleider.

Bij alle onderzoeken van Human Technology Interaction wordt gewerkt volgens de ethische code van het NIP (Nederlands Instituut voor Psychologen). Het gedrag van onderzoeksdeelnemers kan voor onderzoeksdoeleinden worden geregistreerd. De verkregen gegevens worden altijd anoniem verwerkt, en de resultaten worden slechts op groepsniveau gerapporteerd.

Bij deze verklaar ik, (NAAM)............................................ dat ik deze werkwijze begrepen heb en ermee instem om deel te nemen aan onderzoek van de onderzoeksgroep Human Technology Interaction, Technische Universiteit Eindhoven.

__________________________  ______________________
Handtekening       Datum
Appendix E: Mediation models

The relationship between facial similarity and trust in the agent (John) was mediated by self-other overlap. The standardized regression coefficient between facial similarity and trust increased when controlling for self-other overlap. When participants felt more similar to the virtual similar agent, they trusted him more. Furthermore, facial similarity was a significant predictor of trust and of self-other overlap, and self-other overlap was a significant predictor of trust while controlling for facial similarity. Sobel $z = 2.147$, $p < 0.032$, *$p < 0.05$.

The relationship between facial similarity and liking in the agent (John) was mediated by self-other overlap. The standardized regression coefficient between facial similarity and liking increased when controlling for self-other overlap. When participants felt more similar to the facially similar agent, they trusted him more. Furthermore, facial similarity was a significant predictor of liking and of self-other overlap, and self-other overlap was a significant predictor of liking while controlling for facial similarity. Sobel $z = 2.15$, $p < 0.03$, *$p < 0.05$. 

![Diagram](image)